
 WinModel 

 Copyright © 1991 - 1993, Pete Goodwin. All rights reserved. 

 Scene editor for POVray V2.0 
 WinModel is a scene editor designed to output POVray scene files. It is a desktop based 

application, very similar to draw, except it manipulates three dimensional objects. It handles 
all of POVray's simple objects (such as planes, spheres, cubes, cylinders and cones) as well 
as providing a superset of the more complex objects (such as polygons and definitions ); 
 Shareware 
 Terminology 
 Main Menu 
 Selecting Objects 
 Raytracing 
 Creating Objects 
 Copying Objects 
 Editing Objects 
 Groups Defintions & Differences 
 Scope 
 Views 
 Options 
 Solid Editor 
 Polygon Editor 
 Reporting Problems 
 To be Implemented 
 History 



SHAREWARE 

 WinModel is SHAREWARE. If you like it, please send me £40: 
 Pete Goodwin, 
 15 Essex St., 
 Reading, 
 Berkshire, 
 RG2 0EH, 
 England 

 WinModel is distributed "as is" without any warranty of any kind. 
 IN NO EVENT SHALL PETER GOODWIN BE LIABLE OR RESPONSIBLE FOR ANY LOSS 

DAMAGE OR OTHER PROBLEM CAUSED BY USING WINMODEL. THE ENTIRE RISK OF USING 
WINMODEL IS YOURS. 



Terminology 

 textures are special effects applied to the surface of an object. Textures can affect 
colour or the shape of an object. More than one texture can be applied provided there is a 
transparent colour. 

 objects are the basic building blocks in WinModel; they can be simple objects or more 
complex. 

 scope is a collection of objects that may be related; a scope is a convenience function in 
editing, in that it makes no difference to the output scenefile to POVray. It is similar to layers 
seen in other drawing packages. The name layer is avoided since it implies some kind of 
three dimensional effect. 

 definitions are a special type of object - a defined object is a collection of objects that 
provide a master definition for a series of other objects. The other objects are based on the 
definition, and will follow any changes made to the master definition. 

 groups are special type of object, similar to definitions. The difference is that groups are 
unique, and not based on a master definition. 



Main Menu 

 File 
 Edit 
 Object 
 View 
 Options 
 Window 



File menu 

 New 
 Open 
 Save 
 Save as 
 Save Selected 
 Import Colours 
 Load Textures 
 Load Definitions 
 Save Options 
 Save Textures 
 Save Definitions 
 Save Default 
 Generate Scene 
 Print 
 Print Preview 
 Print Setup 
 Exit 



Create a new blank empty scene. 



Open an existing scene and display in a new window. 



Select Save WinModel scenefile to save the current scene. If the scene has no name, 
WinModel will prompt you for one. 



Select Saveas WinModel scenefile to save the current scene. WinModel will prompt you for 
a name, supplying the existing name as a default. 



Save the currently selected object or objects. The filename is Libfile since the format is 
library to allow the objects to be included in other scenes. 
 To be implemented 



Load a text file containing colours in the format: 
 'name' 'red' 'green' 'blue' 
 where 'name' is the name of the texture; 'red', 'green' and 'blue' are floating point values 

describing the value of RGB for the colour. Each colour is created as a simple texture. 



Load default texture file. 



Load default definitions file. 



Save options (grid, scale etc.). 



You can save currently loaded textures. The default is textures.mdb 



Definitions that are currently loaded can be saved. The default filename is defines.mdb 



You can save the default scene. On first loading, WinModel has only one object created 
(other than the three system objects). This is a floor with a Green texture. 



Select Save POVray scenefile to save in POVray format the current scene. This will also set 
the name used in Trace. 



Print the current view to the printer. 



Display a printer preview of the current view. 



Enter dialogs about setting up the printer. 



Exit causes the WinModel application to quit; it first prompts you if a scene has been 
modified for you to save it. 



Edit menu 

 Undo 
 Cut 
 Copy 
 Paste 



To be implemented 



To be implemented 



To be implemented 



To be implemented 



Object menu 

 Create 



Create 

 Select an object from either the menu or the toolbar. It will be selected; from now any 
clicks in the scene window will create an object of the type you selected. 
 Camera 
 Point Light Source 
 Area Light Source 
 Plane 
 Sphere 
 Cube 
 Cone 
 Cylinder 
 Solid of Revolution 
 Polygon 
 Heightfield 
 Disc 
 Torus 
 Definition 
 Quadric 
 Quartic 
 Cubic 
 Polynomial 



Camera 

 A camera object is a dual object that consists of an 'observer' and 'observed' object. The 
line drawn between the two in non- perspective modes shows the notional link between 
them. 

 To use perspective mode, a camera must exist and be selected; this is also true of 
generating a POVray scene. 



Point Light Source 

 A Point Light source is a point of light - it has x, y and z coordinates and nothing else. A 
colour can be applied to a Point Light source. 



Area Light Source 

 An area light source is represented by a cube. It has a direction in that it shines parallel 
light along the axis of the box. 



Plane 

 A Plane is an infinite sheet. You can position it, rotate it, but scaling is meaningless. 



Sphere 

 A Sphere is a spherical object. It can be scaled in any axis, so that flattened balls can be 
created, or long shapes created. 



Cube 

 A Cube is a box shaped object. It can be scaled in any axis, and rotated. It cannot be 
distorted to a rhomboid shape. 



Cone 

 A Cone is a special form of cylinder that generally has a point at one end, and a circular 
disk at the other. The basic form of cone has two radii, one zero and the second 1.0. These 
radii can be varied since a cone is a Solid object. 



Cylinder 

 A Cylinder is a long rod shaped object. It can be scaled in any axis, and squashed, say, to 
create a strut in a framework. The shape can be varied since it is a Solid object. 



Solid of Revolution 

 A Solid object, or more correctly known as a Solid of Revolution, is a complex object 
constructed from cylinders and cones. The radius at any point can be varied along the axis 
of the object. Cones and Cylinders are simple examples of Solid objects, and can be edited 
as Solid objects with the Solid Editor. 



Heightfield 

 Create an object based on a heightfield file. 



Disc 

 A disk object is a flat round object with an optional hole. 



Torus 

 A torus object is doughnut shaped. 



Polygon 

 A polygon object is made up of any number of triangles. Each individual triangle can be 
manipulated with the polygon editor. 



Definition 

 A definition is an object that is defined, i.e. built out of other objects. It is similar to a 
group except there is one description of the whole set of objects that is common to all 
objects based on a definition. 



Quadric 

 Quadric surfaces can produce shapes like ellipsoids, spheres, cones, cylinders, 
paraboloids (dish shapes), and hyperboloids (saddle or hourglass shapes). Quadrics are 2nd 
order polynomials. A quadric has ten values which are used in this equation: 

 A x^2 + B y^2 + C z^2 + D xy + E xy + F yz + G x + H y + I z + J = 0 
 Quadrics are always associated with a bounding object in WinModel. The bounding object 

is usually a sphere or cube. Quadrics are not displayed as their surface in WinModel; only the
bounding object is shown. 



Quartic 

 Quartics are 4th order polynomials. 



Cubic 

 Cubics are 3rd order polynomials. 



Polynomial 

 Polynomial are nth order, where n can be 2 - 7. Special cases of polynomial are Quadric - 
2nd order polynomials, Cubic - 3rd order polynomials, or Quartic - 4th order polynomials 



View menu 

 Toolbar 
 Status bar 
 Home 
 Perspective 
 Front 
 Back 
 Top 
 Bottom 
 Left 
 Right 



The toolbars display frequently used 'tools' in WinModel. They can be hidden by toggling the 
View -> Toolbar menu item 



The status bar displays menu help and prompts whilst WinModel is working. The status bar 
can be hidden by toggling the View -> Status bar menu item. 



Homing the current scene will centre the display on the axis. This feature does not work on 
Perspective. 



Perspective views offer a view that will be rendered by POVray, or more accurately, a view 
through the currently selected camera. Perspective view is NOT available until the first 
camera is created, or a camera object is selected as camera. 



Front view offers a view from the 'front', looking down the Z axis (where +ve Z leads into the
distance), where X runs left to right, and Y bottom to top. 



Back view offers a view from the 'rear', looking down the Z axis (where -ve Z leads into the 
distance). where X runs right to left, and Y bottom to top. 



Top view offers a view from above, looking down the Y axis (where -ve Y leads into the 
distance), where X runs left to right, and Z runs bottom to top. 



Bottom view offers a view from below, looking up the Y axis (where +ve Y leads into the 
distance), where X runs left to right, and Z runs top to bottom. 



Left view offers a view from the left, looking down the X axis (where +ve X leads into the 
distance), where Z runs left to right and Y runs bottom to top. 



Right view offers a view from the right, looking down the X axis (where -ve X leads into the 
distance), where Z runs right to left and Y runs bottom to top. 



Options menu 

 Frame 
 Grid 
 Scale 



Frame menu 

 Frame... 



Grid menu 

 Grid... 



Scale menu 

 Scale... 



Window menu 

 Main menu... 



Selecting 

 Click on Info to display a list of current objects in the scene. The columns displayed are: 
name of object, type of object and what surface is presently applied to the object. The first 
three objects are always present: observer, observed and cursor. These are of type system 
and always have no surface. They act like other objects except they cannot be deleted, nor 
can surfaces or textures be applied to them. 



Raytracing 

 Click on Trace to start POVray. The dialog box displayed allows you to change the name of 
the POVray scenefile about to be written. POVray will be started to trace the scenefile. You 
will be presented with the POVray environment window. Click on start to accept the default 
and begin raytracing. 
 To be implemented 



Creating Objects 

 Select an object you wish to create, then click anywhere in the current view to place the 
object there. 



Copying Objects 

 The currently selected object can be copied by choosing the Copy option. Anywhere you 
click inside the main window will create a copy of the reference object. 
 To be implemented 



Editing Objects 

 Main menu... 



Groups, Definitions and 
Differences 

 Groups, Definitions, Blobs and Differences are very similar types of object in that they 
collect together many objects and treat them as one. The big difference between a group 
and a definition is that a group is a one-off collection whereas a definition can be many 
objects all sharing the same definition. Blobs and Differences are special forms of Group 
object. 
 To be implemented 



Scope 

 Scopes are a special type of grouping of objects. By creating a scope called 'Body' and 
putting objects that make up a body into it, by deselecting the Body scope, all objects in that
scope cannot be selected. This makes selection easier where objects overlap. 

 A special scope is called Definition. All undefined objects are created here - hence 
redefining is simply a case of selecting only the definition scope and selecting all objects. 
The definition scope is a convenience feature for this purpose. 
 To be Implemented 



Views 

 The main window has a series of view of the current scene. Editing can be performed in 
any view, except for Perspective where dragging objects is not possible, although moving 
them with the keyboard or toolbox is possible, and selecting objects still works. 



Options 

 Options... 



Solid Editor 

 The Solid Editor is activated by editing details of a solid. A line is displayed which when 
the object is created is swept around the origin. Points on the line may be created or 
deleted, enabled wine bottle shapes vases etc. to be created. 
 To be Implemented 



Polygon Editor 

 The polygon editor is activated by editing a polygon object and selecting details. The 
main window displays all views (except perspective) of the polygon object. 
 To be implemented 



Problems 

 WinModel is still early days yet! Please report any problems to me. I need to know what 
you were doing, were there any scene files generated etc. 



To be Implemented 

  Implement the TBI's!!! 
  Get better help! 
  Fix perspective where an object falls behind the observer. 
  Allow cameras to be selected by clicking on them! 
  Extend textures. 
  Get POLYGON editor going. 
  Get SOLID editor going. 



History 

 WinModel is complete rewrite of !Model, a C application written for the Acorn Archimedes. 
Model itself is a variant of !PowerEdit, a scene editor for !Powershade, a machine code 
raytracer based on Rayshade. Regrettably Powershade never made it into the commercial 
world despite being a fast raytracer. 

 Model V1.0 was based on VOGLE. Since the Acorn Archimedes didn't have floating point 
hardware, and VOGLE was a 3d graphics library relying heavily on floating point, Model V1.0 
was very slow. 

 PowerEdit and Model V2.0 was a rewrite using integer arithmetic to speed up calculations.
I scrapped the use of VOGLE and created my own library based on notes from a graphics 
book. 

 WinModel is my 6th attempt to create a version of Model for the PC. Original versions 
started in Turbo C++ for Windows, but switched to Visual C++ simply because the class 
library seemed to be better on Visual C++. The compiler is really slow on my 4Mbyte PC. 



Very Ordinary Graphics Learning Environment. 



The Acorn Archimedes is a powerful 32 bit RISC computer designed and created in 
England. The CPU can be found in the Apple Newton PDA. 



Acorn Computers Limited, Fulbourne Rd., Cambridge, CB1 4JN, England 



Powershade is a raytracer based on Rayshade. Powershade was written by Roger Attrill. 
Regrettably it has never been finished, and I wrote the scene editor !PowerEdit for it on 
which !Model and WinModel are based. 



Poweredit is a scene editor written for !Powershade, a raytracer written for the Acorn 
Archimedes. 



Peter Goodwin, 15 Essex St., Reading, Berkshire, RG2 0EH, England 





 Model Help Index

How To ...
How to use Model...

Commands
File menu
Edit menu
View menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

NewCreates a new document.OpenOpens an existing document.CloseCloses an opened 
document.SaveSaves an opened document using the same file name.Save AsSaves an 
opened document to a specified file name.PrintPrints a document.Print PreviewDisplays the 
document on the screen as it would appear printed.Print SetupSelects a printer and printer 
connection.Exit
Exits Model.



Edit menu commands

The Edit menu offers the following commands:

UndoReverse previous editing operation.CutDeletes data from the document and moves it to
the clipboard.CopyCopies data from the document to the clipboard.PastePastes data 
from the clipboard into the document.Paste LinkPastes from the clipboard a link to 
data in another application.LinksList and edit links to embedded documents.



View menu commands

The View menu offers the following commands:

ToolbarShows or hides the toolbar.Status BarShows or hides the status bar.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New WindowCreates a new window that views the same document.CascadeArranges 
windows in an overlapped fashion.TileArranges windows in non-overlapped 
tiles.Arrange IconsArranges icons of closed windows.Window 1, 2, ...Goes to specified 
window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

IndexOffers you an index to topics on which you can get help.Using HelpProvides general 
instructions on using help.AboutDisplays the version number of this application.



New command (File menu)

Use this command to create a new document in Model.    Select the type of new file you want
to create in the File New dialog box.    << Remove previous sentence if your application 
supports only one document type. >>

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

<< Delete this help topic if your application supports only one document type. >>

Specify the type of document you wish to create:
<< List your application's document types here >>



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
<< List your application's file types here. >>

Drives
Select the drive in which Model stores the file that you want to open. 

Directories
Select the directory in which Model stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    Model> suggests 
that you save changes to your document before you close it.    If you close a document 
without saving, you lose all changes made since the last time you saved it.    Before closing 
an untitled document, Model displays the Save As dialog box and suggests that you name 
and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, Model displays the Save As dialog box so you can 
name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    Model displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Model adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application 
chooses via the OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your Model session.    You can also use the Close command on the 
application Control menu.    Model prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    
Modify this help text accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Model, such as File Open.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Model,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below according to which ones your 
application offers. >>

Click To

Open a new document.

Open an existing document.    Model displays the Open dialog box, in which you can 
locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, Model displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Reverse the last editing.    Note:    You cannot undo some actions.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Model window.    To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

Model displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Model and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Model.



Context Help command 

Use the Context Help command to obtain help on some portion of Model.    When you choose
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question 
mark.    Then click somewhere in the Model window, such as another Toolbar button.    The 
Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:

Application Control-menu button

Document Control-menu button

Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Model window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Model determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Model determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the MDL window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>

                              





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

AllPrints the entire document.SelectionPrints the currently selected text.PagesPrints the 
range of pages you specify in the From and To boxes.Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Model is sending output to the printer.   
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>

    


